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Abstract

The times in the all-technological era now have many changes including changes in reading books. People read
in the form of physical books and there are also those who read books in the form of digital e-books (Electronic
Book) on computers, laptops or smartphones. Epub (electronic publication) is a digital book format, which is a
standardized form, introduced by the International Digital Publishing Forum (IDPF) in October 2011. Epub
replaces the role of Open eBook as an open book format. Epub consists of multimedia files, html5, css, xhtml,
xml which are made into one file with the .epub extension.

Epub is one of the most popular digital book formats today, as a format that does not refer to any particular
developer, Epub has several advantages over other digital book formats, Epub has the dynamic characteristic of
adapting to the screen size of a laptop device, computers or smartphones and has other advantage features.
Sigil is an open-source editor for EPUB developed by Strahinja Markovic in 2009 and maintained by John
Schember since 2011. As a cross-platform application, it is distributed for Microsoft Windows, Mac OS X and
Linux platforms under the GNU GPL license. Sigil supports WYSIWYG and code editing based on EPUB files,
as well as import of HTML and plain text files. SIGIL is an editor application for creating digital books in Epub
format which are Open Source

Researchers used literature studies as a research reference by collecting documents from several library sources
needed in the study. This is done to obtain the information and data needed for this study using a sigil editor
application for making digital books in the epub format. From this research, the researcher digs up knowledge
so that this knowledge can be realized at STMIK Citra Mandiri Padangsidimpuan. Therefore, the author will
examine "HOW TO MAKE E-BOOK (Electronic Book) USING SIGIL FEATURES" which later this research
will be made in a journal. Hopefully it can be useful for the author himself and for readers. Hopefully this
research can produce useful knowledge for researchers and STMIK Citra Mandiri Padangsidimpuan and also
the reading public.
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Abstrak

Perkembangan zaman di era serba teknologi sekarang banyak perubahan termasuk juga perubahan dalam
membaca buku. Orang membaca dalam bentuk buku fisik dan juga ada yang membaca buku dalam bentuk digital
e-book (Electronic Book) di komputer, laptop maupun di smartphone. Epub (electronic publication) merupakan
salah satu format digital book yang merupakan format standardisasi bentuk, diperkenalkan oleh International
Digital Publishing Forum(IDPF) pada Bulan Oktober Tahun 2011. Epub menggantikan peran Open eBook
sebagai format buku terbuka. Epub terdiri atas file multimedia, html5, css, xhtml, xml yang dijadikan satu file
dengan ekstensi .epub.

Epub merupakan salah satu format buku digital yang paling populer saat ini, sebagai format yang tidak mengacu
kepada salah satu pengembang tertentu, Epub mempunyai beberapa kelebihan fitur dibandingkan format buku
digital yang lain , Epub memiliki karakteristik yang dinamis dapat menyesuaikan diri dengan ukuran layar
perangkat laptop, komputer maupun smartphone dan memiliki fitur kelebihan lainnya.

Sigil adalah editor open-source untuk EPUB yang dikembangkan oleh Strahinja Markovic pada tahun 2009 dan
dikelola oleh John Schember sejak tahun 2011. Sebagai aplikasi cross-platform, itu didistribusikan untuk
Microsoft Windows, Mac OS X dan platform Linux di bawah lisensi GNU GPL. Sigil mendukung WYSIWY G
dan mengedit kode berbasis file EPUB, serta impor HTML dan file teks biasa. SIGIL merupakan aplikasi editor
untuk membuat buku digital berformat Epub yang bersifat Open Source

Peneliti menggunakan studi literatur sebagai referensi penelitian yaitu dengan mengumpulkan dokumen dari
beberapa sumber pustaka yang diperlukan dalam penelitian. Hal ini dilakukan untuk memperoleh informasi dan
data yang diperlukan untuk penelitian ini menggunakan aplikasi editor sigil untuk pembuatan buku digital
berformat epub. Dari penelitian tersebut peneliti menggali ilmu agar ilmu tersebut dapat direalisasikan ke STMIK
Citra Mandiri Padangsidimpuan. Oleh karna itu penulis akan meneliti “CARA PEMBUATAN E-BOOK
(Electronic Book) DENGAN MEMANFAATKAN FITUR SIGIL” yang dimana nanti-nya penelitian ini akan di
buat Jurnal semoga dapat bermanfaat bagi penulis sendiri maupun untuk pembaca . Semoga dari penelitian ini
dapat menghasilkan ilmu yang bermanfaat untuk peneliti maupun STMIK Citra Mandiri Padangsidimpuan dan
juga masyarakat yang membaca.
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1. Pendahuluan

Perkembangan teknologi di zaman sekarang ini telah
banyak perubahan dan perkemabangan termasuk juga
dalam membaca buku di komputer, laptop maupun
Smartphone. Di zaman sekarang ini masih banyak
penjualan buku fisik maupun buku digital e-book
(Electronic Book). Buku fisik jika disimpan waktu
yang lama dapat mengalami degradasi kualitas kertas
sehingga terjadi pelapukan kertas yang mengakibatkan
buku rusak bahkan bisa habis dimakan rayap. Jika
buku tersebut rusak, maka catatan buku yang memiliki
ilmu pengetahuan, sejarah,seni, dan sebagainya akan
hilang dimakan masa.

Di masa teknologi sekarang yang berkembang pesat
minat pembaca e-book secara signifikan berkembang
dan banyak diminati disebabkan banyak pengguna
laptop, komputer dan juga smartphone. Smartphone
dari tahun ke tahun mengalami penjualan yang tinggi
sehingga banyak pernerbit maupun penulis buku
berlomba membuat buku digital e-book (Electronic
Book) karna mempunyai kelebihan dapat di
kombinasikan dengan suara, video mau pun gambar
daripada buku biasa yang hanya dapat dibaca dengan
teks dan gambar saja.

E-book adalah sebuah versi elektronik dari sebuah
buku tercetak yang dapat dibaca pada sebuah personal
komputer atau alat lain yang didesain khusus untuk
membaca e-book (Danang-2009) . Sementara Putu
Laxman Pendit (2008) berpendapat buku elektonik
adalah buku cetak yang diubah bentuk menjadi
elektronik untuk dibaca di layar monitor. Dari
beberapa pendapat ahli penulis memberi kesimpulan
bahwa buku digital e-book (elektronik book) adalah
buku yang dapat di baca di perangkat elektronik
smartphone, komputer maupun laptop yang dapat
didesain lebih menarik dengan menambahkan gambar
, audio, video agar lebih mudah dipahami oleh
pembaca. Untuk membuat e-book dengan tampilan
yang lebih menarik dibutuhkan aplikasi editor untuk
memanajemen e-book, penulis menggunakan aplikasi
editor Sigil.

Sigil merupakan aplikasi untuk manajemen dan
pembuatan e-book berformat epub yang bersifat open
source dikembangkan oleh Strahinja Markovic pada
tahun 2009 dan dikelola oleh John Schember sejak
tahun 2011. Sebagai aplikasi cross-platform, itu
didistribusikan untuk Microsoft Windows, Mac OS X
dan platform Linux di bawah lisensi GNU GPL
Peneliti nantinya akan mengumpulkan berbagai
referensi dari berbagai sumber untuk pembuatan e-
book. Dari penelitian tersebut peneliti menggali ilmu
agar ilmu tersebut dapat direalisasikan ke STMIK Citra

Mandiri Padangsidimpuan. Oleh karna itu penulis akan
meneliti “CARA PEMBUATAN E-BOOK (Electronic
Book) DENGAN MEMANFAATKAN FITUR SIGIL
Ver.0.9.4” , yang dimana nanti-nya penelitian ini akan di
buat makalah semoga dapat bermanfaat bagi penulis
sendiri maupun untuk pembaca.

Berdasarkan latar belakang , maka perumusan yang akan
dibuat dalam penelitian ini adalah bagaimana cara
membuat buku digital e-book (Electronic Book)
menggunakan fitur Sigil dengan format Epub, dengan
batasan penelitian sebagai berikut :
» Menggunakan Studi Literatur untuk mengumpulkan
dokumen dar berbagai sumber sebagai referensi.

» Aplikasi editor Menggunakan Sigil Ver. 0.9.4
» Buku Digital berformat epub
» Buku yang akan di edit menggunakan format html
» Bahan materi buku digital dari peneliti

Tujuan penelitan untuk membuat buku digital e-
book (electronik book) dengan menggunakan fitur sigil .
Manfaat penelitian ini adalah memberikan ilmu
pengetahuan bagaiamana cara pembuatan e-book
menggunakan fitur sigil bagi penulis sendiri dan juga
STMIK Citra Mandriri Padangsidimpuan pada Program
Studi Sistem Informasi serta pembaca penelitian ini,
sehingga dari hasil penelitian ini nanti dapat di
realisasikan di kehidupan masyarakat.

Targer luaran penelitian ini adalah sebagai
berikut, dijelaskan dalam tabel 1 :

Tabel 1. Rencana Target Pencapaian

No  Jenis Luaran Indikator
Pencapaian
1. Publikasi llmiah Jurnal Ber ISSN Submitted
2. Pemakalah dalam Internasional
temu fImiah Nasional Terdaftar
3. Bahan Ajar Draft
4. Artikel Terbit

2. Metode Penelitian

Metode penelitian yang digunakan dalam pembuatan
e-book menggunakan aplikasi sigil ver.0.9.4 sebagai
berikut:

2.1. Rancangan Penelitian

Penelitian ini merancang model pembuatan buku digital
(Electronic Book) yang mampu memberikan inovasi
untuk sistem informasi khususnya dalam lingkup STMIK
Citra Mandiri Padangsidimpuan . Peneliti menggunakan
metode studi literatur yaitu dengan mengumpukan
referensi dari berbagai sumber dan metode pengumpulan
data dengan mengambil data pustaka, membaca,
mencatat, dan mengolah bahan penelitian untuk
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pembuatan buku digital berformat epub .Dengan tujuan
khusus sebagai berikut: menganalisis cara pembuatan
E-Book menggunakan fitur SIGIL yang akan
diterapkan pada STMIK Citra Mandiri
Padangsidimpuan untuk menambah ilmu pengetahuan
Program Studi Sistem Informasi STMIK Citra Mandiri
Padangsidimpuan.

2.2. Jenis Penelitian

Metode penelitian ini bersifat kualitatif yaitu jenis
penelitian yang menghasilkan penemuan-penemuan
yang tidak dapat diperoleh dengan menggunakan
prosedur-prosedur statistik atau cara-cara lain dari
kuantifikasi (pengukuran) (Strauss dan Corbin).

2.3. Studi Literatur

Penelitian dengan studi literatur merupakan penelitian
yang persiapannya sama dengan penelitian lainnya akan
tetapi sumber dan metode pengumpulan data dengan
mengambil data di pustaka, membaca, mencatat, dan
mengolah bahan penelitian. Meskipun merupakan
sebuah penelitian, penelitian dengan studi literatur tidak
harus turun ke lapangan dan bertemu dengan
menggunakan metode wawancara. Data-data yang
dibutuhkan dalam penelitian dapat diperoleh dari
sumber pustaka atau dokumen. Pada riset pustaka
(library research), penelusuran pustaka tidak hanya
untuk langkah awal menyiapkan kerangka penelitian
(research design) akan tetapi sekaligus memanfaatkan
sumber-sumber perpustakaan untuk memperoleh data
penelitian (Zed, 2014).

2.4. Analis dan Perancangan

Dalam pemilihan metode penelitian ini penulis
mempunyai alasan untuk memilih aplikasi sigil dan
epub sebagai format buku digital adalah sebagai
berikut:

. Format epub dapat menyesuaikan ukuran layar
berbagai perangkat seperti smarthphone, tablet,
laptop ataupun komputer.

«  Aplikasi sigil bersifat opensource yang artinya
memiliki fitur fitur yang gratis

. Format epub mendukung fitur audio dan video

*  Aplikasi sigil bersifat multiplatform yang
artinya dapat dijalankan di sistem operasi
windows, linux dan Mac OS.

SRR ITITY T wEe

Gambar 1. Tampilan Sigil Ver 0.9.4

Tampilan sigil ver 0.9.4 pada gambar di atas terdapat tiga
panel panel kanan, tengah dan atas. Panel kanan book
browser berguna untuk menampung beberapa file pada
epub seperti text, images, font , audio video dan lainnya.
Panel tengah section pada sigil ver 0.9.4 berguna untuk
menampilkan e-book yang akan kita edit ke format epub.
Panel kanan Tabel of content berguna untuk daftar isi
pada dokumen yang sedang kita buat ke format epub.

Untuk membuat e-book ke format epub kita harus
menyediakan file/dokumen yang berisi materi yang telah
siap kita kerjakan di Ms word dengan format doc ataupun
docx yang nantinya akan kita konfersi ke format Web
Page dengan cara pada save as pada Ms Word lalu pilih
Web page, Filtered

Ise;arah word 2007 j
Viord Document j
Word Document

Word Macro-Enabled Document

Word 97-2003 Document

Word Template

Word Macro-Enabled Template

Word 97-2003 Template
PDF

XPS Document
Single File Web Page

\eb Page, Fitered
Rich Text Format

Plain Text

Word ¥ML Document
Word 2003 XML Document

Strict Open XML Document
OpenDocument Text

Gambar 2. Konversi format doc/docx ke format web

Setelah kita buat ke format Webpage selanjutnya kita buka
dokumen yang kita simpan tadi caranya klik file > add >
Exsisting Files , sehingga hasilnya seperti ini :
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Gambar 3. Dokumen yang dibuka menggunakan sigil

Setelah dokumen kita buka menggunakan aplikasi sigil
kita bisa edit dengan menggunakan edit menggunakan fitur
pada sigil seperti menambahkan link, manambahkan
audio, video dan lain sebagainya, dalam penelitian ini saya
akan memasukan file video ke dalam dokumen yang kita
buat tadi pada aplikasi sigil , ikut langkahnya berikut ini :

« Pilihicon insert file

»  Pilih Video

»  Pilih Other Files

«  Pilih video yang akan kita masukkan, disini saya

masukkan video dengan nama word 2007

* laluklik open

untuk lebih jelasnya perhatikan pada gambar Gambar 4 :

e e | 2]
L die o Cancel Fl

Gambar 4. Langkah 1 sampai 3

X
v 3 [ search werd 2007_fles 2] A i

-1 8 = ||| [ab] |a8] (ab| an

8 Dowriasds
| Recent Flaces image001

i Leraries
5 Documents
i Peres

H veess

B Computer
& Locai Dk £)
s Loesl Dk (09)
a Local Digic {2}
o

File naeme: {word 2007 B

Gpen Concel

angan bisnis pada tang
latform Windows vista. Di
processor dapat denga
da, baik pada sistem jai
prd 2007 adalah penge

Gambar 5. langkah 4 sampai 5
Maka hasilnya sebagai berikut :

sotah mengalami banyak

¢ Pergguna akan mendapatkan banyak hal b
dimantaatcan dalam mendukung kuaktss kena pekenaan

Gambar 6.Hasil memasukkan video kedalam dokumen aplikasi sigil

Selanjutnya kita akan membahas tentang MetaData Editor
pada aplikasi sigil, fitur ini berguna untuk menambahkan
Nama penulis, ISSN, ISBN, Tanggal pembuatan
dokumen, Nama Penerbit dan lain sebagainya. Pada
penelitian ini saya akan menambahkan nama penulis
menggunakan MetaData Editor caranya klik Tools -
MetaData Editor atau bisa menggunakan shortcut dengan
menakan F8 pada keyboard

=203
8 ——
Table Of Contents G D D E
Index G
— Spelcheck , prowea Fuarny
Reformat HTML » penyediakan
Epub3 Tools > Hari setiap p
Well-Formed Check EPUB F7
Validate Stylesheets With W3C fd 2007 ser
Reports. .. culsshiftsn  fAr berbeda
Clip Editor... cuiaiic  [n0aN cepat
Saved Searches... Crl+alt+F ung kualitas
Delete Unused Media Files. ..
Delete Unused Stylesheet Classes. ..

Gambar 7.Tools MetDaa Edito?
Setelah kita klik MetaData Editor maka akan muncul pop
up Metadata Editor , pilih Add Metadata—>pilih Author
sebagai penulis , untuk lebih jelasnya perhatikan Gambar
8

2
vy
=
n
| n
n
N
Add Property
=
| =
REDESENTS & DrMary sumhr of the boak o pubcaton
1o |
= =

Gambar 8. Pop Up pada MetaData Editor

Setelah itu edit Author dengan cara klik dua kali pada
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dc:creator ubah nama penulis disini saya ubah Author Setelah kita berhasil membuat e-book dengan format epub

dengan nama saya Ahmad Indra harahap lalu tekan ok

T

Freee Juiak

= dcoestor Ahmad Indra harshan

oof... aut

=

o v ok o 1871

Ditawarkan oleh: readium.org

Ekstensi

Al

E

A 700.000+ pengguna

Gambar 9. Menambahkan nama penulis pada Sigil

Setelah kita menambahkan materi ,video, nama penulis
selanjutnya kita akan menambah cover/sampul pada e-
book caranya yaitu klik menu Tools->Add Cover :

bl

| oois v

Search

wWindow Plugins Help

F&

”<“'u Al Adh er...
[A| Metadata Editor...
EI IE Table Of Contents
Index
Spelicheck
_ Reformat HTML
Epub3 Tools

Well-Formed Check EPUE

Validate Stylesheets With W3C

F7

Reports... Ctri+shift+r €
Clip Editor... Cirl+Alt+C r
Saved Searches... Ctrl+Alt+F L

Delete Unused Media Files...

Delete Unused Stylesheet Classes...

=
Gambar 10. Menambahkan Cover pada e-book

lalu pilih Others Files cari cover untuk e-book . Ketika
sudah ditambahkan maka hasilnya tampilannya terdapat

pada Gambar 11

T
i
i
g
L]

f;-;im.i‘
.
:

Gambar 11. Tampilan Cover e-book epub pada aplikasi sigil

Selanjutnya simpan dokumen yang kita buat ke dalam
format epub klik File->Save As buat nama file dan

simpan.

3. Hasil dan Pembahasan

selanjutnya kita akan melihat hasil e-book yang kita buat.
Untuk menampilkan e-book berformat epub Kkita
memerlukan aplikasi untuk membaca sebuah e-book
berformat epub, ada berbagai macam aplikasi untuk
membuka e-book berformat epub diantaranya adalah
sebagai adalah :

* Untuk Google Chrome pada Sistem operasi Windows
desktop instal Readium kita bisa mendapatkannya di
Chrome Web Store secara gratis

£ chrome web store

Beranda > Apl > Readium

®

Gambar 12. Readium pada Google Chrome

Readium
Ditawarkan cleh: readium.crg
% % % & # 1871 | Ekstensi

A 700.000+ pengguna

 Untuk Smartphone Android instal Lithium kita bisa
mendapatkannya di google Playstore secara gratis.

Lithium: EPUB Reader

FaultException Buku & Referensi

¥

khkad LE0 8

» Untuk Smartphone Iphone instal Apple Books kita
bisa mencarinya di App Store Aple dan ini juga gratis.

m Tambahkan ke Wishiist

Gambar 13. Lithium pada Google Playstore

App Store Preview

This app is available only on the App Store

Apple Books (i
Books & audiobooks you'll love
Apple

Free

Gambar 14. Apple Books pada App Strore

3.1. Hasil
Sekarang mari kita tampilkan hasil e-book yang kita buat
sebelumnya dengan format epub
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Buku Praktik

Microsoft Word & Excel

Gambar 16. Tampilan epub pada Smarthpone

3.2. Pembahasan

Dari Gambar 15. dan Gambar 16 dapat kita lihat bahwa
buku digital berformat epub dengan menggunaka n
aplikasi dapat digunakan di berbagai perangkat dan
berbagai sistem operasi dan untuk menggunakan aplikasi
sigil sangatlah mudah dipelajari untuk membuat e-book
atau buku digital bagi anda para pembaca.

4. Kesimpulan

Buku digital atau e-book dengan format epub mempunyai
tampilan yang dinamis dibandingkan dengar format e-
book lainnya ,karena dapat menyesuaikan ukuran
dokumen di berbagai perangkat dan diberbagai sistem
operasi seperti perangkat smartphone, laptop, Pc dan di
berbagai sistem operasi seperti Windows, Linux , MacOs
dan juga android.

Dalam aplikasi sigil Ver 0.9.4 untuk membuat e-book
berformat epub mempunyai banyak fitur yang tidak ada
di e-book lainnya seperti menambahkan audio dan video
menambahkan author atau penulis, tanggal, nama
penerbit dan juga banyak fitur — fitur lainnya. Dalam
penelitian ini saya sebagai penulis dapat membuat e-book
berformat epub dengan menggunakan aplikasi sigil ver
0.9.4 dengan mudah, ada berbagai macam tutorial dalam
pembuatan epub menggunakan aplikasi sigil ini, bagi
pemabaca dapat mempelajarinya juga di dalam penelitian

saya ini. Sekian dan terimakasih bagi pembaca mohon
maaf bila penelitian ini mungkin masih ada yang kurang
bagi pembaca kedepannya insyaallah penulis akan
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